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Introduction

Topics in this chapter:

B About WiretapCentral on page 1
B About this Guide on page 2
B Contacting Customer Support on page 3

About WiretapCentral

Autodesk® WiretapCentral 2010 Extension 1™ 2010 Extension 1 is a fully integrated Web application that
provides interactive access to all media assets in your facility network. It presents editorial, visual effects,
and grading assets stored on any network-accessible Stone or standard filesystem.

The intuitive Web interface eliminates the need to be at an Autodesk creative workstation to import, play,
encode media, or to submit and monitor background jobs. This allows the artist to offload media management
and transcoding, and stay focused on creative tasks.

WiretapCentral 2010 Extension 1 straddles several different technologies, including Autodesk Visual Effects,
Finishing and Colour Grading workstations, low-bandwidth Web video, and several different networking
and collaboration protocols and tools.
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WiretapCentral 2010 Extension 1 enables you to directly import REDCODE RAW and multi-channel OpenEXR
files by leveraging the Autodesk® Wiretap™ Gateway.

When importing media, WiretapCentral 2010 Extension 1 can use Autodesk® Backburner™ distributed
background processing to maximize efficiency.

About this Guide

Notation Conventions

A number of style conventions are used throughout your documentation. These conventions and examples
of their use are shown as follows.

Convention Example

Text that you enter in a command line or shell appears install rpm -ga
in Courier bold. Press the Enter key after each com-
mand.

Variable names appear in Courier, enclosed in angle <filename>
brackets.

Feedback from the command line or shell appearsin ~ 1imit coredumpsize
Courier.

Directory names, filenames, URLs, and command line  /usr/discreet
utilities appear in italics.

Related Documentation

Documentation for this release is installed with the product as PDF files and as an HTML help system, and
is also available on the Autodesk web site at http://www.autodesk.com/me-documentation. From this page you
can access the complete documentation library.

You should also refer to the product release notes for all late-breaking release information.

2| Chapter 1 Introduction



Contacting Customer Support

For Autodesk Media and Entertainment Customer Support, visit http://www.autodesk.com/support.

Customer support is also available through your Autodesk reseller. To find a reseller near you, consult the
reseller look-up database at http://www.autodesk.com/resellers.

Contacting Customer Support | 3
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Using Wiretap Central

Topics in this chapter:

Overview on page 5

WiretapCentral 2010 Extension 1 User Interface on page 6
Browsing using the Network Tree on page 8

Browsing using Thumbnails on page 9

Browsing Using the List View on page 11

Using the Player on page 12

Overview

WiretapCentral 2010 Extension 1 presents a Wiretap network as a hierarchy of hosts, volumes, projects,
libraries, reels and clips. When you first point a web browser to the WiretapCentral 2010 Extension 1 server,
the network tree lists all hosts detected on the network. Clicking on a host (which is the top-level data node)
reveals its volumes, and so on down the hierarchy, to clips.

The network tree works in conjunction with the main view area to give you a more complete picture of the
network and volume contents. Initially the main view area is empty. Once you start navigating a host, it
displays the contents of the host’s volumes, libraries, and reels, as you select them. By default it displays
thumbnails for each clip, but it can also display clip metadata in a list view mode.

WiretapCentral 2010 Extension 1 can browse volumes on Autodesk Visual Effects and Finishing workstations.
With Wiretap Gateway, it can browse volumes on Lustre workstations and any storage device accesible on
the network.

NOTE Clips stored on a Finishing workstation’s EditDesk or a Visual Effects workstation’s Desktop are not accessible.




WiretapCentral 2010 Extension 1 User Interface

The user interface consists of three main areas, as shown in the following diagram.

a b c

Selection  Layout View  Bookmarks Tools  Import  Export Help

» hpb- 15:Gateway o

> hpb- 15:IFFS ’% ’%

* indianapolis:Gateway :
* jalapa:Gateway
» kamloops:Gateway stonefs stonefs?
¥ kamloops:IFFFS.
> stonefs
* stonefs7
» kiev:Gateway
* higali:Gateway
* kigali:IFFFS

ts and Finishing
(Build 3680)

HOST

(a) Network tree (b) Details area (c) Main view area

Network Tree

The network tree displays the contents of the Wiretap network in a tree hierarchy. Initially, it lists all the
hosts discovered. Expanding a host displays its volumes, and the projects and clip libraries within.

namur:WiretapBridge
newcastle:IFFFS
c stonefs
1080_25psf
1080_29p
1280_253976
1280_55i
Default
f Default Source Area

1280_60p_test

(a) Host (collapsed) (b) Host (expanded)
(o) I;ramestore (d) Project (e) Library (f)
Ree
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Main View Area

The main view area occupies a central portion of the UL It presents clip thumbnails, the list view, and the
player. Switch between these display modes using the View menu, or double-click a thumbnail to open the
player immediately.

Tools = Import

caterpillar_1 HO [>  caterpillar_1

00:00 . 1% _1,§:_;ﬁ+15 Vi1
00:00:00:02 | | oof
AS81 ADD1_CD90_082 [>

(a) Clip Thumbnail (b) Play/Pause button (c) Scroll Bars

Details Area

When you browse, the information for the node that you are currently on, whether server, volume, project,
library, or clip, is presented in the Details areas. This information persists until you select another node.

Clip Detalls
ADD1_C090_08203V_001.R3l
04 12-bit u (rgh_le)
ource Timecode \ 415
Tape Name ADD1_CO90_08203V
Creation Date
. Start Keycode MNone

Frame Rate 23.98

Project Details

Name

Y Width 360

"

Main View Area | 7



Changing the Layout

To change the layout of the user interface, select an option from the Layout menu.

Select To

Normal Display the network tree, the main area, and the details area. If displaying the player on
higher-resolution monitors, this should be enough to show the whole frame.

Extended Hide the details area, giving more space in the main area for thumbnails or list view items.

Full Screen Hide the network tree and the details area, leaving only the main area. This is most useful
when you need the most size in player mode.

Browsing using the Network Tree

The network tree is an interactive tool for browsing the network and volume hierarchy. It works in conjunction
with the main view area to show clips as thumbnails or in a list view.
a b c

Selection Layrout View Bookmiirks Tools  Import Export Help

¥ newcastle:IFFFS = | [15:16:16+15 Vi1

¥ stonefs 3 In
1

> 1080_25psf

> 1080_29p i

¥ 1280_23976 ADD1_CO90_082 P>
¥ Default T

> 1280_59i

» 1280_60p_test 00:00:00:02

> 192025 e [ —

S i6r0501 > | | caterpillar

* 19205994 H h 00:00:00:pE Vi1

* 1920_2%976 : i

> 1920_24psf test

» 1920_5994i

2k caterplllar_1_HD [>  caterpillar_2 >  caterpillar_2_HD |

(a) Network tree with library selected (b) Draggable divider (c) Main view area showing
clip thumbnails

To browse the network:

1 Click any host item in the network tree to display its volumes. While multiple volumes can be present,
typically a host has just one volume — stonefs, for example.

Icons representing the volumes appear in the main view area, when in thumbnail mode.

NOTE When you expand an item in the network tree an animated cursor indicates that a metadata transaction
is taking place. Depending on the complexity of the tree, this can take some time.

8| Chapter 2 Using Wiretap Central



2 Click a volume in the network tree to display its projects.
Icons for the projects appear in the main view area.

HD_vZ008 MNSTC_10bit_SMOKEZ0075P4. NTSC_10bit

3 Click collapsed items to further expand the network tree.

B The data structure hierarchy is exactly what you would find browsing a clip library in any Autodesk
Visual Effects and Finishing workstation.

B Once an item is expanded, you can collapse it again by clicking its expand/collapse arrow.

B To switch between expanded items, click the item of interest. This changes the focus without
collapsing the deselected item.

4 To expand all an item’s selection at once, from the Selection menu, choose Expand Children.

5 To refresh the view, choose either Refresh All or Refresh Selection.

Using Bookmarks

Create and use bookmarks to keep track of frequently used locations by selecting an option from the
Bookmarks menu. You can choose to add a bookmark for the currently shown location, or to go to a previously
saved bookmark. You can also remove an unused bookmark.

Managing Libraries and Reels

You can create new libraries and reels in a project, on an accessible volume, by choosing the appropriate
option from the Tools menu. You can also add/remove directories on a Wiretap Gateway server. You can
also remove any clip, and some nodes, by using the Delete option.

NOTE The option that allows deleting is on by default but can be turned off in the configuration file, which is
found at /var/www/html/WiretapCentral/wiretapcentral.cfg. Under the Permissions section, uncomment the line:
DeleteEnabled=false.

Browsing using Thumbnails

By default, the main view area presents the Wiretap network and volume content as icons and thumbnails.
For example, if a library is selected in the network tree, the main view area displays icons for the reels it
contains. When you select a library or reel, thumbnails are generated for their clips. Once you have selected
a host in the network tree, you can do all of your downward browsing using icons and thumbnails.

To browse using thumbnails in the main view area:
1 Switch to thumbnail mode, if necessary, by selecting Thumbnails from the View menu.

2 In the network tree, double-click the icon for the volume of interest.

The main view area displays the projects contained by the selected volume.

Using Bookmarks | 9



3 Continue browsing the contents of the current host:
B Double-click any icon to open it.

B Double-click a clip thumbnail to switch the main view area to player mode and load the clip into
the player.

B To navigate back up the tree or to switch hosts, select another node in the network tree.

Playing Thumbnail Previews

Icons and thumbnails in the main view area provide an intuitive means to navigate the network and volumes.
More importantly, the thumbnails provide you with:

B Metadata corresponding to each clip, including the clip’s name, timecode, duration, and tracks.
B A playable, scrubbable representation of the clip.

B A gateway to loading the clip directly into the player.

To play thumbnail previews in the main view area:
1 Navigate to the clip of interest.
By default, a single-image thumbnail is automatically generated for each clip in the main view area.

a b c d

15:16:16+15 W1

Li.- In E Al

(a) Current timecode (b) Duration (c) Audio track indicator (d)Video track indicator (e) Clip name (f) Scrubbable
progress bar icon (g) Play/Pause icon

2 Click the progress bar to generate the playable thumbnail.

Thumbnail generation is normally faster than real-time, depending on the network interface and
processing power of the WiretapCentral 2010 Extension 1 server. Thumbnails are partially playable and
scrubbable even when processing or downloading is not yet complete.

The meaning of the different colours is explained below.

Time Bar Colour Description
orange corkscrew Thumbnail is not yet encoded.
grey A grey progress bar indicates thumbnail is being generated. Grey from start-to-finish

indicates thumbnail is generated and resides in your browser’s cache.

blue Playable thumbnail has been generated on the server, but remains to be downloaded
into your cache.

yellow Indicates position when playing or scrubbing.

10 | Chapter 2 Using Wiretap Central



3 Play the thumbnail by clicking the Play icon.
4 Scrub the thumbnail by dragging over the progress bar.

Browsing Using the List View

By default, the main view area displays the contents of the current library or reel as clip thumbnails. The
list view presents an alternative view, presenting clips in table format, with sortable, repositionable columns.

Selection  Layout  View  Bookmarks  Tools  Import

¥ newcastle:IFFFS = Name yp T Duration KCIn | TapeMame  FPS
SMPTE_75 -bi 00: 00:01: VIRTUAL 29.97

i seo=s SMPTE_75  CLIP 00 VIRTUAL 29.97

* 1080_25psf

» 1080_29p

¥ 1280 23976
¥ Default

b 1280 590
» 1280_60p_test

The list view allows you to locate or compare clips based on clip metadata, such as name, tape name, and
duration.

When used in conjunction with the Selection menu Expand Children command, you can list all the clips
in all ‘subdirectories’, as well as the library structure, of any network object — host, volume, project, library
or reel — in one click.

Browsing and Viewing Clips in the List View

The list view presents clip metadata in a sortable table with repositionable columns.

To browse and view clips using the list view:
1 In the network tree, navigate to the library or reel of interest.

2 From the View menu, select List View.

The list of clips contained in the library or reel appears in the list view. The list view contains one row
for each clip in the current library or reel.

Optional: Rearrange columns by dragging them to their new position.
Optional: Sort the list by clicking a column header.

Select a row to view its thumbnail in the Clip Details area.

AN U b~ W

Optional: Expand the selection of any network item — a host, volume, project, library or reel — all at
once. From the Selection menu, click Expand Children.

A confirmation dialog appears, cautioning you that the operation can take some time.

7 Click OK in the dialog.

This populates the list view with information on all nodes found in the sub-hierarchy, including clips,
reels, libraries, and projects.

B In the Network tree, a spinning cursor indicates the recursive scan is in process. All sub-items are
expanded.

B As the scan proceeds, the list view is populated by the incoming stream of metadata.

Browsing Using the List View | 11



B Once complete, the results persist until you select something else in the Network tree. However, the
data is cached locally for the duration of the session. The second time you expand the selection in
the same place the results are loaded immediately.

8 To switch back to thumbnail mode, from the View menu, select Thumbnails.

Using the Player

Thumbnails are convenient for previewing clips, but the player is larger and offers considerably more playback
options. It presents clips at a width of 720 pixels, and usually at 100% JPEG quality. In addition, the player
has controls for stepping through the action, looping, and playing backward.

From most areas of the user interface, double-clicking a clip opens the player and loads the clip into it.
WiretapCentral 2010 Extension 1 automatically generates and downloads the high-resolution version from
the clip on the volume, then streams the playable version to the player. For long clips, this can take a few
seconds, depending on the network interface and processing power of the WiretapCentral 2010 Extension
1 server. If the clip has an NTSC or PAL proxy on the volume, the process is usually very close to real-time.
As with thumbnails, you can begin playing as soon as the clip begins downloading.

Loading a Clip into the Player

To load a clip into the player:
1 Navigate to the clip of interest.

2 Double-click on the clip to open the player and load the clip. You can double-click a thumbnail or a
row in the list view.
The player appears in the main view area with the clip loaded.

The progress bar indicates how much of the clip has been downloaded. Clips in the player are partially
playable and scrubbable even when processing or downloading is not yet complete.

The meaning of the different colours in the time bar is explained below.

Time Bar Colour Description
orange corkscrew Clip is not yet playable.
grey A grey progress bar indicates a playable clip is being generated. Grey from start-to-

finish indicates the clip is generated and resides in your browser’s cache.

blue Playable clip has been generated on the server, but remains to be downloaded into
your cache.
yellow Indicates position when playing or scrubbing.

3 To switch back to the previous view mode, from the View menu, select either Thumbnails or List View.

Playing a Clip

You can play a clip using the player controls, as shown in the following diagrams.

12 | Chapter 2 Using Wiretap Central
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00:00:00+00 | 00:00:00+11  Home

a b c d
(a) Loop/mute/smooth display (b) Playback controls (c) Time bar (d) Zoom controls

The playback controls are detailed below.

a b c d e f g h

(a) First frame of clip (b) Back one frame (c) Fast
backward (d) Pause (e) Play (f) Fast forward (g)
Forward one frame (h) Last frame of clip

Panning and Zooming a Clip
You can pan the clip across the canvas and zoom in and out, even while the clip is playing.
To pan and zoom a clip:

1 To pan the clip, drag it using the mouse.

2 To zoom in and out:
B Click the [+] and [-] UI buttons.

B Use the wheel on the mouse.

3 To reset the player’s default pan and zoom settings, click Home.

4 To fit the clip to the available player canvas, click Fit.

Panning and Zooming a Clip | 13
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Decoding RED Media

Topics in this chapter:

About Importing RED Media on page 15

Importing RED R3D Media Files on page 16

Importing FCP XML Containing RED Media Files on page 18
Importing an EDL Containing RED Media Files on page 21
Adjusting the Settings on page 24

Defining the Output Destination on page 28

Submitting the Job on page 30

Monitoring the Job on page 31

About Importing RED Media

RED digital cameras record RAW media that is compressed using a proprietary codec known as REDCODE™,
which is saved as an R3D™ file. R3D files contain very high-resolution digital images (2K, 4K, or even higher).
These files require a computational-intensive debayering process to transcode to a file format that can be
read by Autodesk Visual Effects and Finishing applications.

WiretapCentral 2010 Extension 1 can prepare a reel of clips, originating from RED source material, for
conforming in an Autodesk Visual Effects and Finishing application. WiretapCentral 2010 Extension 1 is
used to set up R3D transcoding jobs, which are sent to a Backburner network for decoding, leveraging a
network of processing nodes (any Linux-based computers, including the application workstation) to provide
maximum processing speed. The jobs output image sequences to a location that is accessible to Autodesk
Visual Effects and Finishing applications.

RED media can be imported as individual R3D files, or as either Apple® Final Cut Pro® XML or generic EDL
files that contain RED media.

15



Importing RED R3D Media Files

RED media can be imported as individual R3D files.
1 In WiretapCentral 2010 Extension 1, from the Import menu, select RED.
This starts a new import job. The Import Red window appears.

Import Red

Input | Settings = Output = Submit | Job Monitor

R3DFlles | FCPXML  EDL

Timecode  Primary ) Sd_e(tc_ll_ps D

Input# e Id : Tape Name

2 Enter a session name. Special characters are prohibited.

The session name identifies your import job when saving or loading a session, and when outputting
the job. It is also the job name in Backburner Manager.

Import.R"ed

Session Name
Input | Settings = Output = Submit = Job Monitor
R3DFlles | FCPXML  EDL

Timecode  Primary ) Sd_e(tl.‘_.ll_ps D

Input# e Id 2 Tape Name

3 Optional: Save the session. At any time, you can save a session. From the Session button, select Save or
Save As. Use the Session button to load a previously saved Import Red session or delete one.

WARNING Sessions are saved as cookies. Deleting your browser cookies deletes your saved sessions. On
Firefox, using the Clear Recent History option deletes the browser cookies.

4 Ensure that the Input tab is selected.
5 From the Input tab, ensure that the R3D Files tab is selected.

6 From the R3D Files tab, select the Timecode to use.
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9

10

From the R3D Files tab, click Select Clips.
A browser appears.

By browsing through a Wiretap Gateway, select one or more RED clips and click Add.
Select multiple files at a time by using the Shift or Ctrl key.

Select Source Red Clips
Selection  Layout  View  Bookmarks

AD01COB5 = ] 15:16:16+15

ADO1 COB6 s

A001_COBT. N

A001_COBB M AE—

A001_COBO. ADD1_C090_082 >

A001_C090

A001_CO91

annd Fini ¥

Clip Details

Name ADD1_CO090_08203V_001.R3D
lution 408 12-bit u (rgh_le)
ce Timecode 15:16:16+15

Tape Name AD01_C090_08203V

Creation Date

b
b
»
b
b

v
»

None

23.98

Select clips and click 'Add’.

The number of clips selected is displayed at the bottom of the screen.
When you are finished, click Done.
The selected clips appear in the Input list.

Import Red

Input | Settings = Output = Submit = Job Monitor
R3DFlles | FCPXML EDL
Timecode  Primary Seled:CIIps “Delete Selected  Clear List

Input#
1

NOTE To verify the timecode used: if the Src TC columns matches either Edgecode or TOD TC (time of day)
columns, the clip will be imported using the matching timecode. If it matches neither, the clip will be imported
using the primary timecode.

When you are ready to proceed, click the Settings tab.
See Adjusting the Settings on page 24.
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Importing FCP XML Containing RED Media Files

If you are importing an FCP XML pointing to RED media, then you must make sure to take the right steps
in Final Cut Pro.

Working in Final Cut Pro

For interoperability with FCP, there are a minimal number of steps that must be performed before importing
into WiretapCentral 2010 Extension 1.

1 Ensure that the original R3D files are stored in a location that is accessible to FCP.

2 Using REDRUSHES™, convert the R3D files into the QuickTime® DVCPRO HD format. Use DVCPRO720
and burn-in the timecode.

This is a less CPU-taxing format that you can easily import into Autodesk Visual Effects, Finishing, or
Grading applications, and keep your entire edit, audio included, as a reference.

NOTE Do not modify the R3D filenames. Instead, use the various comment columns to identify your clips.
Make sure that you keep the full 16-character filename as a reel name.

3 Edit in FCP using the QuickTime files (created in step 2) that contain the full original R3D filename.
Be aware that the FCP XML file will be used in your Autodesk Visual Effects, Finishing, or Grading
application, and that not all transitions, effects, and speed changes are supported. Consult your Autodesk
Visual Effects, Finishing, or Grading application user guide.

4 Export an FCP XML of the final sequence for use in your Autodesk Visual Effects, Finishing, or Grading
application.
1 Select the sequence in the FCP browser.

2 Choose File > Export > XML.

3 Select Apple XML Interchange Format, version 4.
B Do not select Include Master Clips Outside Selection.

B Select Save project with latest clip metadata (recommended).

The generated XML file points to the QuickTime files that you used for your offline editing.

5 Copy the source R3D files, the QuickTime files, and the FCP XML to a media folder on a SAN or NFS.
Ensure that:

B The media folder is accessible from both WiretapCentral 2010 Extension 1 and your Autodesk Visual
Effects, Finishing, and Grading application.

B You keep the same file/folder hierarchy where one folder contains all .RDM and .RDC folders and
subfolders. It makes it easier to search for and match events to media when loading the FCP XML.

B You place the FCP XML in the top folder. This enables WiretapCentral to find automatically the
underlying media during the import process.

Avoiding the Log&Transfer Tool

If you use the Log&Transfer tool to ingest R3D files, the Reel name of the imported clips has a directory
name. You will then have to manually rename each Reel to their 16-character RED filename.
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Also, the Log&Transfer tool often imports only parts of clips over 4 GB, dividing them up while adding a
“_17,“_2" to the filename, which hinders relink operations later on.

Examples of faulty filenames: A clip named A001_C004_0206T9, imported in FCP using Log&Transfer, is
renamed A001_C004_0206T10. A clip named A001_C004_0206TB, imported in FCP using Log&Transfer, is
renamed A0O1_C004_0206TB1.

Using the xml_adsk_tapename Script

The QuickTime files created in REDCINE™ have tape names that match the first four characters of the R3D
filenames, such as AOO1. But WiretapCentral requires the full 16-character tape names. If you edit in FCP
and export an XML with those QuickTime files, you need to convert the tape names back to 16-character
format. Use the Python script installed by WiretapCentral to perform this conversion.

The Python script is located in the /usr/discreet/wiretapcentral/scripts/ directory. Use it to process
the FCP XML.: it replaces the four-character tape names with the ones extracted from the header of the
QuickTime file. You can then use the FCP XML in WiretapCentral.

The script creates a new copy of the processed XML file. To use it, put the script in a same directory as the
FCP XML file and type:

xml adsk_tapename.py name of the file to modify.xml name of the destination_ file.xml
For example, to modify the tape names in abc.xml, navigate to the directory containing abc.xml and type:

xml adsk tapename.py abc.xml abc fixed.xml

Importing FCP XML

New for this release: If Search for Sources cannot locate a RED file, you can use Locate Source to manually
assign a RED file to an event.

RED media can be imported as FCP XML pointing to R3D files.

1 In WiretapCentral 2010 Extension 1, from the Import menu, select Red.
This starts a new import job. The Import Red window appears.

2 Enter a session name. Special characters are prohibited.

The session name identifies your import job when saving or loading a session, and when outputting
the job. It is also the job name in Backburner Manager.

Cm poﬁ Red

Input | Settings = Output = Submit | Job Monitor
R3DFlles | FCPXML EDL
Primary

Input# Id | Source Name Tape Name
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3 Optional: Save the session. At any time, you can save a session. From the Session button, select Save or
Save As. Use the Session button to load a previously saved Import Red session or delete one.

WARNING Sessions are saved as cookies. Deleting your browser cookies deletes your saved sessions. On
Firefox, using the Clear Recent History option deletes the browser cookies.

4 Ensure that the Input tab is selected.
5 From the Input tab, select the FCP XML tab.

6 From the FCP XML tab, click Load XML File.
A browser appears.

7 Navigate to the folder containing the FCP XML file to be imported, and select the file.

Select FCP XML Flle

Selection Layout View Bookmarks

¥ MAF_tests
* RED_TimeCode_shots
¥ TEST
> XDCAM EX
* tmp Edit. xml House_1.xml
P owt

b calinuy

8 Click OK.
The events from the selected XML file appear in the Input list.

9 Select the Timecode to use.

10 Click Search for Sources to have WiretapCentral 2010 Extension 1 search the contents of a folder for
the sources. A browser appears.

11 Navigate to the folder containing the R3D files. The files themselves are not displayed.

12 Select the location of the RED media files and click OK. WiretapCentral 2010 Extension 1 searches the
folder and all subfolders for each clip referenced in the XML.

In the list, the Status of each event with a located source changes from Missing to Found.

13 Optional: For each event with the Missing status:
1 Select the event for which to locate an R3D file.

2 Click Locate Source. A browser appears.
3 Navigate to the R3D file, and select it.
4

Click OK to link the R3D file to the event.
In the list, the Status of the event changes from Missing to Found.
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NOTE To verify the timecode used: if the Src TC columns matches either Edgecode or TOD TC (time of day)
columns, the clip will be imported using the matching timecode. If it matches neither, the clip will be imported
using the primary timecode.

14 When you are ready to proceed, click the Settings tab. See Adjusting the Settings on page 24.

Importing an EDL Containing RED Media Files

If you are importing an EDL file pointing to RED media, then you must make sure to take the right steps in
your editing application.

Working in Avid

If you are editing in your Avid® application, you will need to export EDL sequences, since WiretapCentral
2010 Extension 1 does not support AAFE.

Keep in mind that you will need to export one or more EDLSs, so limit your edit to one video track. If you
must edit using several tracks, you will have to make as many duplicates of your sequence as you have video
tracks and remove any additional video from the duplicates. You will end up with several EDL files, one per
video track.

NOTE When editing in Avid Media Composer, export an EDL using Avid EDL Manager and the RED16 template
(available at www.avid.com/red). The tape name of each event then has the required 16 characters. Use the
Python script provided with WiretapCentral to modify the Avid EDL and build a tape source table which works in
WiretapCentral and in your Autodesk Visual Effects and Finishing software.

To export EDL files:
1 Edit your sequence in your Avid application.
2 Pare down your Avid sequence to make it more EDL-friendly.

3 Make as many duplicates of your sequence as you have tracks, and prepare video-only sequences,
carefully naming each one.

4 Export each Avid sequence as a new EDL with the Avid EDL Manager using the following settings:
B Set EDL type to RED16.

B In the Options menu, set Reel ID Type to Cameraroll.
B If Edgecode was used instead of TOD Timecode, set the Source TC option to Auxiliary TC 1.
|

Select the option that includes the source table with the saved EDL.

5 Repeat step 4 for each video track’s corresponding sequence.

6 Copy the source R3D files, the fixed EDL to a media folder on a SAN or NFS. Ensure that:

B The media folder is accessible from both WiretapCentral 2010 Extension 1 and your Autodesk Visual
Effects, Finishing, and Grading application.

B You keep the same file/folder hierarchy where one folder contains all .RDM and .RDC folders and
subfolders. It makes it easier to search for and match events to media when loading the EDL file.

B You place the EDL in the top folder. This enables WiretapCentral to find automatically the underlying
media during the import process.

Importing an EDL Containing RED Media Files | 21



Using the edl_adsk_tapename Script

The Avid RED16 EDL Manager template has the EDL source table and the tape name of each event which
uses the full 16-character tape name. But the EDL parsing mechanism in WiretapCentral reads standard
CMX events with tape names containing 8 characters or less. It also reads the tape source table.

WiretapCentral installs a Python script, which converts the events and the source table into a format
compatible with WiretapCentral and Autodesk Visual Effects and Finishing systems.

The Python script is located in the /usr/discreet/wiretapcentral/scripts/ directory. It creates a new
copy of the processed EDL. To use it, put the script in a same directory as the Avid EDL file and type:

edl adsk tapename.py name of the file to modify.edl name of the destination file.edl
For example, to modify the tape names in abc.edl, navigate to the directory containing abc.edl and type:

xml adsk tapename.py abc.edl abc fixed.edl

Importing the EDL

New for this release: If Search for Sources cannot locate an RED file, you can use Locate Source to manually
assign an RED file to an event.

RED media can be imported as generic EDLs containing R3D files. The workflow goes as follows.

1 In WiretapCentral 2010 Extension 1, from the Import menu, select Red.
This will start a new import job. The Import Red window appears.

2 Enter a session name. Special characters are prohibited.

The session name identifies your import job when saving or loading a session, and when outputting
the job. It is also the job name in Backburner Manager.

"~ Import Red

Input | Settings | Output | Submit | Job Monitor

R3DFlles | FCPXML | EDL

Time Base 23, 98 fips NOF | Tape Name  Extended | Load EDLFlle  Time

Inputét "l Sour Tape Name [

3 Optional: Save the session. At any time, you can save a session. From the Session button, select Save or
Save As. Use the Session button to load a previously saved Import Red session or delete one.

WARNING Sessions are saved as cookies. Deleting your browser cookies deletes your saved sessions. On
Firefox, using the Clear Recent History option deletes the browser cookies.

4 Ensure that the Input tab is selected.
5 From the Input tab, select the EDL tab.

6 Select the Time Base for your EDL.

You must manually define the timeline’s time base before importing the EDL as the EDL does not this
information.

7 Select how Tape Name is written in the EDL.
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10

11
12

13
14

15

16

If there is a tape name conversion, and the original tape name is written below each event,
WiretapCentral 2010 Extension 1 shows the correct tape name. In the end you must have both the
Source Name and Tape Name fields containing the same data.

Click Load EDL File. A browser appears.
Navigate to the folder containing the EDL file to be imported, and select the file.

Select EDL Flle

Selection  Layout  View  Bookmarks  Tools

¥ MAF_tests

¥ RED_TimeCode_shots
¥ TEST
* XDCAM EX

> tmp House_1.ed|
> wt

¥ selinux

Click OK.
The events from the selected EDL file appear in the Input list.

Select the Timecode to use.

Click Search for Sources to have WiretapCentral 2010 Extension 1 search the contents of a folder for
the sources. A browser appears.

Navigate to the folder containing the R3D files. The files themselves are not displayed.

Select the location of the RED media files and click OK. WiretapCentral 2010 Extension 1 searches the
folder and all subfolders for each clip referenced in the EDL.

In the list, the Status of each event with a located source changes from Missing to Found.

Optional: For each event with the Missing status:
1 Select the event for which to locate an R3D file.

2 Click Locate Source. A browser appears.
3 Navigate to the R3D file, and select it.
4

Click OK to link the R3D file to the event.
In the list, the Status of the event changes from Missing to Found.

NOTE To verify the timecode used: if the Src TC columns matches either Edgecode or TOD TC (time of day)
columns, the clip will be imported using the matching timecode. If it matches neither, the clip will be imported
using the primary timecode.

When you are ready to proceed, click the Settings tab. See Adjusting the Settings on page 24.
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Adjusting the Settings

The Settings tab contains a number of parameters that can be set for the clips in your RED decoding session.
These are divided under the Format and the Color tabs. The settings under these tabs are the staging area
for the RED settings, and are not applied until you click the Apply button.

WiretapCentral 2010 Extension 1 reads the format and color metadata in the clip, as set in the camera, and
populates the parameters as appropriate. You can additively load presets, or change the settings manually.

Settings that are not changed are greyed out. Clicking one will activate all in the group. Settings that are
not enabled will not be applied.

The effects of the settings are displayed on the selected clip, in the Preview panel.

To modify clip settings:
1 Select the Settings tab.
2 In the list, select the one or more clips to edit.

3 Click Load Selected Clip.
The format and color metadata are loaded in the Format and Color tabs.

NOTE If you selected multiple clips, the tabs display only information about the first clip in the list.

4 Adjust the Format and Color settings. See Format Tab on page 25 and Color Tab on page 27.
5 Optional: To discard the changes, click Defaults.

6 Once the adjustements are complete, click Apply to save the modified settings.

Use Restore Camera Settings to restore the original camera settings.

Preview Panel

The new Preview panel allows you to preview the effect of the settings being edited on the selected clip.Use
the Preview panel to monitor the changes to the Format and Color settings. You can also use the Preview
panel to set In and Out markers. These markers define the actual clip to import. They are disabled when
importing clips using an FCP XML or an EDL.

The image displayed in the Preview panel is a 1/8th resolution preview. Enable Full Resolution to view the
clip at full resolution.
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‘Refresh Image

[ Full Resolution

e et i

1212:34+14 | In Duration |00:00:15+16 Out |12:12:50+06

12;12:40+16 [ [¢ @ —— 4 00000 T3] 1 1z1250+06

(a) In timecode (b) Start timecode (c) Mark In button (d) Go To In button (e) In-Out
duration field (f) Mark Out button (g) Go To Out button (h) End timecode (i) Out timecode

Format Tab

New for this release: A new Debayer setting is available (1/16th of resolution). Also, new Crop settings allow
you to crop the image.

Use the Format Settings options to set:
Resize

Crop settings

Debayer quality

Detail level

Optical Low Pass Filter options

Denoise level
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Import Red

Session Name |MartinC.

Input | Seftings | Output | Submit | job Monitor
Presets “load Selected Cllp Restore Camera Settings  Restore RSX Seftings  Select All

[ Depth
AOF1_CO01 020460 | Full 204801024 12

2048 x 1024
Debayered 2048 x 1024
Debayer | Full

»

Crop .
oignX 1Y T @0 W [BefeehThmge

SieWIH [2006 8 [102 | ' | Full Resolution
AspectRatio [N o/ Preserve : |

Reslze
Size W I H

BitDepth 1z |
Fi/Stretch
Filter

Detail

OLPF
Duration |00:
Denoise  OFF

Debayer Select the level of quality required from the debayering algorithm. Higher resolutions take more
time to process.

Crop Enter the desired Crop settings. Setting crop values displays a matching crop box on the clip displayed
in the Preview panel.

Size W | H (Resize) Enter the desired resize settings. A resize setting that is not directly proportional to
the size of the original media takes longer to process. Resize settings are automatically applied when Debayer
is set to something else than Full.

Bit Depth RED media is 16 bits, but must be converted down to 12, 10 or 8 bits.

Fit/Stretch  To use a different aspect ratio during resize, select a fit method option to be applied to the
exported clip.

Select: To:

Centre/Crop Fit the source image, centred, over the destination frame. If the source is larger than the destination,
it is cropped. If the source is smaller than the destination, it is surrounded by a black border.

Crop Edges Fit one edge of the source into the destination frame without stretching or squashing the frame. Excess
parts of the source frame after resizing are cropped.
If the source, after the one edge is resized, is wider than the destination, its overhanging left and right
edges are cropped. If the source is taller than the destination, the upper and lower edges are cropped.

Fill Fit the source, width, and height, into the destination frame. If the source and destination frames do
not have the same aspect ratio, the image can become distorted.

Letterbox Fit the source to the destination frame without squashing or stretching it, and without cropping the
source.
If the source is wider than the destination, black bars fill the top and bottom of the destination frame.
If the source is narrower than the destination, black bars fill the right and left sides of the frame. In all
cases, the entire source frame is contained within the destination frame.

Filter Select the filter option to determine the quality of the interpolated resize result.

Select: To get:
Impulse Quick, low-quality results.
Triangle Moderate results with little processing overhead.
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Select: To get:

Mitchell Best results when resizing a clip to a higher resolution.
Bicubic Very good results for resizing soft-looking images. Use to sharpen the image.
Quadratic Good results for resizing simple images with straight edges. Similar to Gaussian but with more blurring.

Use to soften the image.

Gaussian Excellent results when resizing a clip with no patterns and a lot of straight edges to a lower resolution.
Useful for softening some detail.

Shannon Excellent results when resizing a clip to a lower resolution. Very similar to Lanczos, but results are a
little softer.
Lanczos Best results when resizing a clip containing a variety of patterns and elements to a lower resolution.

It is the most complex with the longest processing time.

Detail Select the level of detail extraction required.

OLPF  Select the level of Optical Low Pass Filter compensation to use. OLPF is a type of sharpening used
to compensate for the optical anti-aliasing filter, which can induce softening of the image during recording.

Denoise  Select the level of noise reduction applied to the debayered clip.

ColorTab

New for this release: RedAlert!™ RSX settings are available, as well as colour spaces PDLog 685 and PDLog
985.

WiretapCentral 2010 Extension 1 supports most color options available in RED applications, such as RED
Alert!™.

The Color Tab displays the settings for the clip metadata, as set in the camera. Alter these settings carefully,
since overiding some values may produce unexpected results.

Load the RSX look created in RED Alert! by clicking Restore RSX Settings. The RSX file of a clip must reside
in the same folder as the R3D file of that clip; this is the default behavior in RED Alert!.

NOTE The Color tab also contains settings for RGB Gain, as well as Color curve settings. We recommend that you
do not change the default settings unless you have prior experience with color management.
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Import Red

Session Name |MartinC.

Input | Seftings | Output | Submit | job Monitor

Presets Restore Camera Settin
Debayer
AOS1_CO01_02046)  Ful 204811020
Gamma Curve
Color Space
IS0
Kelvin

Tint

Exposure & (Eefresli e

Saturation 1 Full Resolution

Contrast

Brightness

White X | ¥
Knee X | Y
MidX | Y

ToeX Y [0z . > .
10:40:44:42 | In Duration [00:01:19:06 out. [10:42:03:47
BlackX | Y _ —
LB 10:40:6682 T e 42:03:47

Gamma Curve Displays the value of the output gamma curve that is applied to the clips.
Color Space  Displays the value of the native color space of the images, as set in the camera.
ISO Displays the value of the linear gain operation. Red images are always shot at 320 ISO.
Kelvin  Displays the perceived color temperature of the image.

Exposure Displays the exposure increments, which are equivalent to f-stops.

DRX Displays the setting for Dynamix Range Extension, which sets how much pixel data is copied from
non-saturated channels into saturated channels.

Defining the Output Destination

Use the Output tab to change how timecode is used in the clip, to use handles, and to set one or more output
destinations for your import RED job. A job can be sent to multiple destinations. The decoding is done once
and streamed simultaneously to each location.

WARNING Be careful when transcoding to a StandardFS volume: if a file with the same name already exists in
the destination folder, it will be overwritten with the newer file.

The clip placeholder is created right away and the media is populated in the background without locking
the clip library in your Autodesk Visual Effects and Finishing application.

1 Click the Output tab.
The output options appear.
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Im pcrr!' Red

Input | Settings = Output Submit = Job Monitor

Handles D

Add... Delete

Clip Path

Click Add to add a destination for the given jobs.
A browser appears.

Select one or more destination locations for the processed clips.

Select Destination

Selection  Layout View Bookmarks Tools

-

» kamloops:Gateway
¥ kamloops:IFFFS
¥ stonefs
¥ stone-test
¥ Default

» stonefs?

Library Detalls

Depending on whether the destination is a StoneFS or a standard, unmanaged filesystem, different
kinds of images sequences will be created.

If the selected destination is a StoneFS on an Autodesk Visual Effects and Finishing workstation,
uncompressed RGB images are generated and the corresponding clips are created in Project/Library/Reel.
Clips are named according to their source R3D file name.

B To create a new library, select a project then, from the Tools menu, select New Library.

B To create a new reel, select a library then, from the Tools menu, select New Reel.

If the selected destination is on a Wiretap Gateway server, then stand-alone DPX sequences are created
in Main folder/Resolution.
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WARNING If a file with the same name already exists in the destination folder, it will be overwritten with
the newer file.

You should create a folder using the project name to identify your clips.
B Select a destination then, from the Tools menu, select New Reel.

The DPX file name is always timecode-based, and is padded to 7 digits. Metadata is maintained in the
DPX header. Other metadata gets written into the XML file that WiretapCentral 2010 Extension 1
produces for each clip.

DPX sequences can be imported directly into Lustre, or as clips in Autodesk Visual Effects and Finishing
applications.

6 When done, click OK.
The selected destinations appear in the Output list.

7 Optional: Set Handles.

In a conforming workflow, you may add extra frames to the heads and tails of clips to provide for
dissolves and other transitions during finishing. Always set handles when importing FCP XML, since
FCP sometimes adds an extra frame at the end of the last clip in the sequence which may cause problems
upon import. WiretapCentral 2010 Extension 1 automatically adds enough handles to cover for
transitions such as dissolves and wipes.

Submitting the Job

Use the Submit tab to set your processing options and execute your job.

1 Click the Submit tab.
Impor‘t'Réd

Input | Settings = Output = Submit = Job Monitor

Job Description  |RedImportTest

Backburner Manager  Santlago | Refresh

Server Group  None

Max Server Count 0 = all servers)
Job Priarity (0 is highest, 100 is lowest)
Email Notification l:l (Email address for job completion/failure 1

Submit Job Clear Status  Copy to clipboard

5t

Set any of the following parameters.
Job Description  Enter the description that will appear in Backburner monitor.

Backburner Manager WiretapCentral 2010 Extension 1 scans the local network for all available
Backburner managers. Select the one to which you want to send the Import Red job.

Server Group  Select the server group (if available) for the given Backburner manager. A server group
is a virtual arrangement of processing nodes. By default, a job will go to all servers (up to the server
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limit), which may not be advantageous to your job or work environment. Server groups need to be set
up in Backburner if you have a processing farm. See the Backburner User Guide.

Max Server Count Select the number of processing nodes to be used on the job.
Job Priority  Set the job priority that is used in Backburner Manager for queued processes.
Email Notification Enter your e-mail address if you want to be notified of job completion or failure.
2 When done, click Submit Job.
Import Red

Input = Settings = Output Submit Job Monitor

Job Description  |RedImportTest

Backburner Manager  Santlago | Refresh

Server Group
Max Server Count (0 = all servers)
Job Priority |5 B (0 is highest, 100 is lowest)

Email Notification l:l (Email address for job completion/failure 1

Submit Job  Clear Status  Copy to clipboard

This sends the jobs to Backburner for processing. The job status (clip creation on all destinations and
submission of the job to Backburner manager) is displayed in the Status list.

Monitoring the Job

Use the Job Monitor tab to follow the progress of all your submitted jobs.

1 Click the Job Monitor tab.
All the currently submitted jobs are displayed along with their status.

Import Red

Input | Settings | Output = Submit | Job Monitor

Action Filter by name l:l ‘SelectAll  Auto Refresh 30 Sec |
2. T Driority mi

22 15

waiting 0/ 3935 30 2008-07-21 10:08:14
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See Monitoring the Decoding Jobs on page 43.
You can also open the Backburner monitor selected in the Destination pane by clicking Web Monitor.

2 When you are done, from the Session box, select Save to keep your session information, then close the
browser to end the session.
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Decoding OpenEXR Media

Topics in this chapter:

About Importing OpenEXR Media on page 33
Importing OpenEXR Media Files on page 33
Adjusting the Settings on page 36

Defining the Output Destination on page 37
Submitting the Job on page 39

Monitoring the Job on page 40

About Importing OpenEXR Media

OpenEXR files are designed to support multiple resolutions and additional channels, making them appealing
for compositing. Since OpenEXR can store arbitrary channels (such as specular, diffuse, alpha, RGB, normals,
etc) in one file, it takes away the need to store this information in separate files. However, to support all
these arbitrary OpenEXR channels in Autodesk Visual Effects andFinishing applications, they need to be
converted to separate sets of RGB clips upon import. These RGB files can then be modified and combined,
for example in Action, to reconstitute the final clip.

WiretapCentral 2010 Extension 1 is used to set up OpenEXR transcoding jobs, which are sent to a Backburner
network for encoding, leveraging a network of processing nodes (any Linux-based computers, including the
application workstation) to provide maximum processing speed. The jobs output RGB image sequences to
a location that is accessible to Autodesk Visual Effects, Finishing, and Grading applications.

NOTE Multi-channel OpenEXR sequences are imported as 16-bit float. OpenEXR sequences at 32-bit float are
converted to 16-bit float automatically.

Importing OpenEXR Media Files

OpenEXR media can be imported as individual multichannel files. The workflow goes as follows.
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1 In WiretapCentral 2010 Extension 1, from the Import menu, select OpenEXR.
This will start a new import job. The Import OpenEXR window appears.

Import OpenEXR

Input | Settings  Output Submit = Job Monltor

OpenEXR Flles

“Select Sequences...  Delete Selected Clear list

Import | Ren ion Duration File N

2 Enter a session name. Punctuation marks are prohibited. WiretapCentral 2010 Extension 1 indicates if
the session name is invalid. Correct the name before going any further.

The session name is used to identify your import job when saving or loading a session, and when
outputting the job. The session name is used as the job name in Backburner Manager.

You can save this session at any time. From the Session menu, select Save or Save As. From this menu,
you can also load a previously saved Import OpenEXR session or delete one.

Input | Settings = Output = Submkt = Job Monltor

OpenEXR Flles
“Select Sequences...  Delete Selected Clear list

Import | Ren 55 1 ion Duration File N,

3 Ensure that the Input tab is selected.

4 From the OpenEXR Files tab, click Select Sequences.
A browser appears.

5 By browsing through a Wiretap Gateway, select one or more clips and click Add.
You can select multiple files at a time by using the Shift or Ctrl key.
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For OpenEXR files containing multiple render passes, you can select the file, to select all render passes,
or double-click the file to show the contained render passes. The render passes can then be added
individually.
Select OpenEXR Sequences
Selection Layout  View Bookmarks  Tools
W openexr =1 [00:00:00+00 1] | 00:00:00+00 :1[]f00:00:00+400 Wil
w aa720_bs_r1_RAW_ex R - ;
w 3a720_bs ri RAW_ i
dave — | —— 2 ——

e ATt AD:AD.sterecCam > { V. CAMZ:depth.stere [>
RenderPassDemo_ste 00:00:00+00 Vi1 21| | 00:00:00+00 Vi1

RenderPassDemo_ste o

RenderPassDemo_ste

00:00:00+01 4 L 00:00:00+01

p openexr-images-1.5.0

» source L DIFF:diffus = REFL:reflection.st [>

1 clip added.

6 When you are finished, click Done.
The selected clips appear in the Input list.

Import OpenEXR

Input | Settings = Output | Submit = Job Monitor

OpenEXR Flles
Select Sequences...  Delete Selected  Clear Ust
it | Render Pa F ion ion File e

CUTO3_Luminance_D
CUTOZ_Beauty.

cuTo3 ; ocal/material/media
cuTo3 und.0001. /DLloc: al/med

7 When you are ready to proceed, click the Settings tab.
See Adjusting the Settings on page 36.
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Adjusting the Settings

The Settings tab contains a number of parameters that can be set for the clips in your OpenEXR decoding
session. These settings appear under the Format tab, and are the staging area for the OpenEXR settings. You
can additively load presets, or change the settings manually. The settings are not applied until you click the
Apply button.

Settings that are not changed are greyed out. Clicking one will activate all in the group. Settings that are
not enabled will not be applied.

When you are done adjusting, click Apply to apply the settings to the selected clips in the list. The settings
can be applied to all of the clips or to individual selections.

Format Tab

Use the Format Settings options to perform any resizing, including resize filter options.
CmportOpensé
Input | Seftings | Output | Subelt | Job Monitor
Apply " Defautts | Presets Load Selected Clip Settings  Restore Clip Settings

Format

Width

]
.

Height
Fit/Stretch  Letterbox

Filter  Bicuble

Width / Height  Enter the desired resize settings.

Fit/Stretch  To use a different aspect ratio during resize, select a fit method option to be applied to the
exported clip.

Select: To:

Centre/Crop Fit the source image, centred, over the destination frame. If the source is larger than the destination,
it is cropped. If the source is smaller than the destination, it is surrounded by a black border.

Crop Edges Fit one edge of the source into the destination frame without stretching or squashing the frame. Excess
parts of the source frame after resizing are cropped.
If the source—after the one edge is resized—is wider than the destination, its overhanging left and
right edges are cropped. If the source is taller than the destination, the upper and lower edges are
cropped.

Fill Fit the source, width and height, into the destination frame. If the source and destination frames do
not have the same aspect ratio, the image can become distorted.
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Select: To:

Letterbox Fit the source to the destination frame without squashing or stretching it, and without cropping the
source.
If the source is wider than the destination, black bars fill the top and bottom of the destination frame.
If the source is narrower than the destination, black bars fill the right and left sides of the frame. In all
cases, the entire source frame is contained within the destination frame.

Filter Select the filter option to determine the quality of the interpolated resize result.

Select: To get:

Impulse Quick, low-quality results.

Triangle Moderate results with little processing overhead.

Mitchell Best results when resizing a clip to a higher resolution.

Bicubic Very good results for resizing soft-looking images. Use to sharpen the image.

Quadratic Good results for resizing simple images with straight edges. Similar to Gaussian but with more blurring.

Use to soften the image.

Gaussian Excellent results when resizing a clip with no patterns and a lot of straight edges to a lower resolution.
Useful for softening some detail.

Shannon Excellent results when resizing a clip to a lower resolution. Very similar to Lanczos, but results are a
little softer.
Lanczos Best results when resizing a clip containing a variety of patterns and elements to a lower resolution.

It is the most complex with the longest processing time.

Defining the Output Destination

Use the Output tab to set one or more output destinations for your import OpenEXR job. A job can be sent
to multiple destinations. The decoding is done once and streamed simultaneously to each location.

The clip placeholder is created right away and the media is populated in the background without locking
the clip library in your Autodesk Visual Effects and Finishing application.

1 Click the Output tab.
The output options appear.
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Import OpenEXR

Input | Settings | Output = Submbt | Job Monitor

Add... Delete Clear list

Server Name Clip Path

2 Click Add to add a destination for the given jobs.
A browser appears.

3 Select one or more destination locations for the processed clips.

Select Clip Destination
Selection Layout View  Bookmarks Tools
w Gregg s _project &
w Default
w OpenEXR
w Red
Jdave Default OpenEXR
JjdaveZ
kandis
Kandis_Smoke2010

mylene_project_DET

The destination can be any StoneFS on an Autodesk Visual Effects and Finishing workstation.
Uncompressed RGB images are generated and the corresponding clips are created in Project/Library/Reel.
Clips are named according to their source file name.

4 To create a new library, select a project then, from the Tools menu, select New Library.
5 To create a new reel, select a library then, from the Tools menu, select New Reel.

6 When done, click OK.
The selected destinations appear in the Output list.
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Import OpenEXR

Input | Settings | Output = Submbt | Job Monitor

Add... Delete Clear list

a3_s5_project/OpenEXR

Submitting the Job

Use the Submit tab to set your processing options and execute your job.

1 Click the Submit tab.

Import OpenEXR

Input | Settings Output = Submit = Job Monitor

Job Description  |OpenEXR

Backburrer Manager
Server Group | 23-26-25-26|
Max Server Count = | servers)
Job Priarity {0 is highest, 100 is lowest)
Email Notification l:l (Emall address for job completion/failure notification)

i Submbt Job Clear Status  Copy to clipboard

Set any of the following parameters.
Job Description  Enter the description that will appear in Backburner monitor.

Backburner Manager WiretapCentral 2010 Extension 1 scans the local network for all available
Backburner managers. Select the one to which you want to send the Import OpenEXR job.

Server Group  Select the server group (if available) for the given Backburner manager. A server group
is a virtual arrangement of processing nodes. By default, a job will go to all servers (up to the server
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limit), which may not be advantageous to your job or work environment. Server groups need to be set
up in Backburner if you have a processing farm. See the Backburner User Guide.

Max Server Count Select the number of processing nodes to be used on the job.
Job Priority  Set the job priority that is used in Backburner Manager for queued processes.

Email Notification Enter your e-mail address if you want to be notified of job completion or failure.

2 When done, click Submit Job.

Import OpenEXR

Input | Settings = Output Submit = Job Monitor

Job Description  |OpenEXR

Backburrer Manager = Innsbruck | " Refresh
Server Group " 23-264-25-26 |

Max Server Count EB (0 = all servers)

Job Priority (0 is highest, 100 is lowest)

Email Notification l:l (Email address for job completion/failure notification)

Submit job  Clear Status  Copy to clipboard

6.128.150:7549.

This sends the jobs to Backburner for processing. The job status (clip creation on all destinations and
submission of the job to Backburner manager) is displayed in the Status list.

Monitoring the Job

Use the Job Monitor tab to follow the progress of all your submitted jobs.

1 Click the Job Monitor tab.
All the currently submitted jobs are displayed along with their status.
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Import OpenEXR

Input | Settings = Output = Submit = Job Monitor

Filter by name I:l Select Al Auto Refresh

Ta Priority
515/ 515
515/ 5
_BICUBIC 515 f 515
__TRIANGLE 515 4 2009-01
S 515/ 515 2009-01
] 01
515/ 515 7 2009-01-
515/ 515 8 2009-01-7
515/ 515 g 2009-01-25
12
180 / 180
180/ 180
186 / 1
G 2009-01-2
2009-01-
2009-01

See Monitoring the Decoding Jobs on page 43.

You can also open the Backburner monitor selected in the Destination pane by clicking Web Monitor.

When you are done, from the Session box, select Save to keep your session information, then close the
browser to end the session.
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Monitoring the Decoding
Jobs

Topics in this chapter:

B Overview on page 43
B Understanding the Monitor User Interface on page 44
B Viewing Job Details and Job Tasks on page 47

Overview

The monitor provided in the media import workflow is suitable for monitoring and controlling your own
recently submitted R3D and OpenEXR jobs. WiretapCentral 2010 Extension 1 also provides a more
comprehensive monitor, available directly from the Tools menu. It has all the features of the monitor
embedded in the media import workflow, plus additional tabs, for managing servers and server groups
associated with the currently selected Backburner Manager, and for modifying the job-handling behaviour
of the Backburner Manager itself.

NOTE There are three monitors available in Backburner: The Backburner Windows Monitor, Backburner Web
Monitor and WiretapCentral Backburner Monitor (described in this chapter). For a comparison of the three, see
the Backburner User Guide.

To gain access to the WiretapCentral 2010 Extension 1 Backburner Monitor:

1 From the Tools menu, select Backburner Monitor.

The WiretapCentral 2010 Extension 1 Backburner Monitor appears in a new browser window or tab
(depending on your browser settings).

2 From the Backburner Manager drop-down list, select the Backburner Manager of interest.
The information in the current tab is updated automatically.
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Backburner Monitor

Manager | camil i Refresh  v2010.1.0 (Build 1375) 1P: 172.16.129.57

Jobs | Servers = Server Groups | Manager

Jobs A Filter by riame |:| Select Al AutoRefresh | 30 Sec

Name
E 516 { 2008-12- 16 07:51
Burn_camiri_081104_14.46.26 0 0/10
allo 100 / 100
dummyjob I ] 71
complete 5 522/ 2145
complete 71171
suspended 0/ 1597
s 0/ 2405
323 f 2145
919 / 1263
0/1263
susanab4lc s nded 0 0/1 2009-01-28 16 2009-01-28

|4

3 You can update the display manually by clicking the Refresh button, or you can set a refresh rate from
the Auto Refresh menu.

4 To perform an operation on a job, select the job in the Jobs tab, then select the desired operation from
the Action menu.

Shift-click or Ctrl-click to perform the same operation on more than one job at a time.

5 To view job details, double-click the job of interest.

User Access Control

By default, no user name or password is needed to use WiretapCentral 2010 Extension 1, and all jobs
submitted from WiretapCentral 2010 Extension 1 to Backburner are owned by user “apache”. As a result,
you can easily perform operations on all WiretapCentral 2010 Extension 1 jobs on the Backburner network,
including suspending, activating, and deleting jobs submitted by other users. In addition, by default the
user “apache” has administrator privileges over all other Backburner jobs, too, such as Burn jobs submitted
by an Autodesk Visual Effects and Finishing application. For information on setting up user access control,
see the WiretapCentral Installation Guide.

Understanding the Monitor User Interface

The standalone monitor user interface features four tabs for viewing job, server, server group and manager
information respectively. This section describes each of these tabs.

Jobs Tab

The Jobs tab presents information relating to all jobs associated with the selected Backburner Manager. Use
it to view and control the decoding jobs submitted from WiretapCentral 2010 Extension 1, as well as to view
jobs submitted to Backburner by other Autodesk Visual Effects and Finishing applications.
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Backburner Monitor

Manager camirl | Refresh ¥2010.1.0 (Build 1375) IP: 172.16.129.57

Jobs | Servers = Server Groups | Manager

Jobs T Adtion | Filter by name |:| Select Al Auto Refresh 30 Sec |

00:00
00

The following table describes the operations available from the Action menu.

Select To

Settings Open the Job Details window for the selected job. See Viewing Job Details and Job Tasks on
page 47.

Activate Resume a suspended job from where it was halted. Tasks that were already completed are left

as-is, and are not redone.

Restart Restart a suspended job and all its tasks from the beginning, setting the job status to waiting.
Suspend Place the job on hold.
Delete Remove the job from the job queue.

The following table presents the information found in the Jobs tab.

Column Description
Name This corresponds to the session name specified when submitting the decoding job..
Status The current state of the job:

complete: Completed successfully.

active: Currently being serviced.
suspended: On hold.

idle: Not scheduled for service.

waiting: Ready, and waiting to be serviced.

% Done Percentage of tasks that have been completed.

Tasks The number of completed tasks and the total number of tasks for the job. For example “55/145"
indicates 55 out of 145 tasks for the job have been completed.

Priority The job priority, from 0 to 100. Zero is the highest priority. 100 means the job is suspended.
Default is 0.

Submitted The time at which the job was originally submitted, in the following format: YYYY-MM-DD
HH:MM:SS

Started The time at which the job started, in the following format: YYYY-MM-DD HH:MM:SS. If the job

has not started, zeros appear for the values.

Elapsed The time duration consumed by the job (HH:MM:SS).
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Column Description

Type The processing engine needed for the job. For example:
Burn: The Burn renderer.
Command Line Tool: The Backburner cmdjob command-line plug-in allows you to submit batch,
executable, or script files to Backburner as “custom” jobs.
mio: The MIO adapter is the processing engine responsible for carrying out transcoding jobs.
Wire: Installed with Stone and Wire. Can be used to import/export media, perform Wire transfers,
etc. Used by the Wiretap SDK’s background 1/O tool, wiretap_bgio_tool.

Owner The name of the user that submitted the job. This value is set automatically by Backburner when
the job is first created. By default, all jobs submitted from WiretapCentral 2010 Extension 1 have
an owner of “apache”.

Servers Tab

The following table presents the information found on the Servers tab.

Column Description

Name Server name (host name).

Description A short description of the server, entered when the server was installed.
Status The current activity of the server:

absent: Server is no longer seen by the manager, possibly down.
active: Server is currently working on a job.

suspended: Server has been put on hold.

idle: Server is inactive.

error: Server is experiencing a problem.

Perf. Index Avalue in the range [0-1] indicating the performance level of the server, relative to other servers
on the same job. A score of 1 indicates this is the best-performing server.

Adapters A comma-separated list of installed plug-ins and adapters, for example:
Burn: The Burn renderer.
Command Line Tool: The Backburner cmdjob command-line plug-in allows you to submit batch,
executable, or script files to Backburner as “custom” jobs.
mio: The MIO adapter is the processing engine responsible for carrying out transcoding jobs.
Wire: Installed with Stone and Wire. Can be used to import/export media, perform Wire transfers,
etc. Used by the Wiretap SDK’s background 1/O tool, wiretap_bgio_tool.

Server Groups Tab

A server group is a collection of render nodes grouped together for the purpose of organizing a render farm.
It acts as a shortcut to multiple render nodes. By default, the Backburner Manager sends a job to all the
render nodes equipped with a suitable processing engine. When you submit a job to a server group, it is sent
to the render nodes within the group only, leaving those outside the group free for other uses.

The following table presents the information found in the Server Groups tab.

Column Description
Name The name of the server group.
Servers A comma-separated list of servers in the group.
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For more information on server groups, see the Autodesk Backburner User Guide.

Manager Tab

Use the Manager tab to set options related to the Backburner network, such logs, server assignments criteria,
job retries, and tasks performed when a job finishes.

Field

Description

Logging Level

Sets the type of events shown in the log files.

Error: Fatal errors that halt the rendering of a job.

Warning: Non-fatal warning information. These are events that do not cause the application to
stop rendering a job.

Debug: Detailed information about TCP/IP packets and the current state of Backburner Manager
and the Backburner Servers.

Debug Extended: A more verbose listing than Debug.

Default Mail Server

The Backburner Manager can send job success/failure notification to the address submitted with
the job (or assigned to the job once it is in the queue). Use this field to indicate the server where
the smtp mailer daemon is running.

Changing this field affects all email notifications for the selected manager—not just those asso-
ciated with your own jobs.

Max Concurrent Jobs

Sets the maximum number of jobs the manager sends out simultaneously. The optimal setting
depends on the processor speed of the manager workstation, general job size, and overall network
speed. Generally, the default value of 4 is adequate. You can change this value in the following
situations:

Decrease this value when rendering jobs are large and/or Backburner is struggling
to keep up with jobs.

Increase this value when rendering jobs are small and/or Backburner has no
trouble keeping up.

Avoid increasing this value substantially. Too high a value may cause an increased number of
node timeouts, because the jobs are sent faster than the nodes can handle them. In such cases,
decrease the value.

Retry Count

The number of times the manager attempts to restart a failed task.

Time Between Retries

The time between each retry.

On Job Completion

Specifies what happens to job parameters once the job has successfully completed.

Leave: Leave in the job list.

Archive after n days: Remove from the job list and place in the job archive after the specified
number of days. Set to 0 (zero) to archive the job immediately after its completion. Archiving
saves a job’s parameters; it does not, however, save rendered frames or source material.
Delete after n days: Remove from the job list after the specified number of days. Set to 0 (zero)
to delete the job immediately after its completion.

Viewing Job Details and Job Tasks

Double-clicking on a job name opens the Job Details window where you can view additional information
about a job, including its associated tasks, where they have been sent for processing, and their status. The
top of the window displays the following information:

Field

Description

Name

The name of the job.
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Field

Description

Type

The processing engine required to complete the job. For example:

Burn: The Burn renderer.

Command Line Tool: The Backburner cmdjob command-line plug-in allows you to submit batch,
executable, or script files to Backburner as “custom” jobs.

mio: The MIO adapter is the processing engine responsible for carrying out transcoding jobs.
Wire: Installed with Stone and Wire. Can be used to import/export media, perform Wire transfers,
etc. Used by the Wiretap SDK’s background 1/O tool, wiretap_bgio_tool.

Node ID

The job’s ID as assigned by the Backburner Manager.

General Info Tab

The following table describes the information found in the General Info tab.

Field

Description

Description

Job description as entered when the job was submitted.

Submitted By

The owner of the job, and the host from which it was submitted.

State

The current state of the job:

complete (%): Completed successfully. The percentage is set by the Backburner Manager as
each task is completed.

active: Currently being serviced.

suspended: On hold.

idle: Not scheduled for service.

waiting: Ready, and waiting to be serviced.

Priority

The job priority, from 0 to 100. Zero is the highest priority. 100 means the job is suspended.
Default is 0.

Email Notification

The address to which job completion or job failure notifications are sent.
When using this feature, be sure to set the location of the mailer daemon too. See Manager Tab
on page 47.

Dependencies

List of jobs that must be completed before the selected job can be processed.

Last Task Error

The last error message for the most recent task (associated with the job) executed by the Back-
burner Manager.

Tasks Tab

The following table describes the information found in the Tasks tab.

Column Description

ID The task number for this task.

Status The state of the task (active, complete, waiting, error).

Server The name of the server where the task is being executed.

Start Time The time stamp at which the task was started (YYYY-MM-DD HH:MM:SS).
Elapsed Time The time duration consumed by the task (HH:MM:SS.MS).
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Column Description

Last Error The last execution error message associated with this task.

Server Assighment Tab

The Server Assignment tab allows you to view the servers assigned to the selected job. It also allows you to
assign new servers or server groups to currently active jobs. A filtering mechanism allows you to limit the
list of servers to those capable of handling the current job type only.

NOTE You can only modify server assignments for jobs having a status of active.

Field Description

Assigned Server Group Name of the server group to which the job was assigned. A server group is a collection of servers.
Only servers in the specified group will work on the job.

Max Server Count Within a server group, the maximum number of render nodes made available for the job, as
specified when the job was submitted. Set to 0 (zero) to assign the job to all servers in the group.

Assigned Servers A comma-separated list of servers currently assigned to the job.

Filter on Job Type Select this checkbox to list only the servers capable of handling the job.

Name Name of the server.

Assigned to Job A checkbox indicating whether or not the listed server is assigned to the job. To add a new

server to the job, check a checkbox. Notice the Assigned Servers list is updated automatically.

Description A description of the server.

Status The current activity of the server:
absent: Server is no longer seen by the manager, possibly down.
active: Server is currently working on a job.
suspended: Server has been put on hold.
idle: Server is inactive.
error: Problem on the server.

Perf. Index Avalue in the range [0-1] indicating the performance level of the server, relative to other servers
on the same job. A score of 1 indicates this is the best-performing server.

Adapters The adapters installed on the server, for example:
Burn: The Burn renderer.
Command Line Tool: The Backburner cmdjob command-line plug-in allows you to submit batch,
executable, or script files to Backburner as “custom” jobs. For more information see the Autodesk
Backburner User Guide.
mio: The MIO adapter engine is responsible for transcoding some streaming media formats
(such as R3D and OpenEXR).
Wire: Installed with Stone and Wire. Can be used to import/export media, perform Wire transfers,
etc. Used internally by Autodesk Visual Effects and Finishing applications.

Advanced Info Tab

Some applications submit Backburner jobs with extended instructions for the processing engine. Use the
Advanced Info tab to view and modify these extended instructions.
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Encoding Clips

Topics in this chapter:

About Encoding Clips on page 51
Supported Export Codecs on page 52
Encoding Clips on page 52

Customizing Encoding Presets on page 56

About Encoding Clips

Encoding clips is a three-step process that is done within the Export window: you select the input clip, set
the processing options, and submit the job. Once the clip is encoded, you have the option of creating a
package (containing all the clips you created), to upload to a web server.

NOTE Only fully-rendered clips can be encoded.

WiretapCentral 2010 Extension 1 guarantees frame and timecode accuracy; however, it is important to note
the following limitations:

Video clips are not broadcast-quality
Clips are down-converted to 8-bits per channel RGB
Film clips lack colour management

All effects must be rendered

Audio must be mixed down to 2 tracks; all other tracks are ignored

With these limitations in mind, it is recommended that any client final approval be done using the final
delivery medium.
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WiretapCentral 2010 Extension 1 encodes clips on the server, and they remain there once complete. The
default storage capacity of this location is set at 20GB. Once this capacity is reached, older clips are
automatically deleted to make room for the new.

To modify the capacity of the storage, edit the configuration file found at
/var/www/html/WiretapCentral/wiretapcentral.cfg. Under the Export section, uncomment the line: SizeGB=20
and set the size (in gigabytes).

Supported Export Codecs

WiretapCentral 2010 Extension 1 can export clips in the following formats. New for this release: settings
for iPhone™ and iPod® exports.

Codec

Comments

H.264

Main, High. Use Main when you want to minimize the use of computing resources. This is
the setting used by QuickTime Pro. Use High for broadcast or disc storage at high-definition,
such as for HD DVD or Blu-Ray.

iPod Touch/iPhone

H.264 format for iPhone™ and iPod Touch®

iPod 5G H.264 format for video-capable iPod®
MPEG-4

MPEG-2

MPEG-1

FLV Flash Video

QT Animation QuickTIme file using the Animation codec

DV (PAL or NTSC)

Raw PAL or NTSC DV stream

MS MPEG-4

Microsoft MPEG-4 version 2

Encoding Clips

Encode clips using the following procedure.

To encode a clip:

1 From the Export menu, choose Selected or Entire List.

The export window appears.
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Export

Input = Output Settings | Submit

ce Path

2 Name the export session.
Export

Input = Output Settings | Submit

Source Name Source Path

This name is used to create a subdirectory on the server to hold the encoded clips. If no Session name
is entered, the name of the first clip selected, when entering the export panel, is used.

You can save this session at any time. From the Presets menu, select Save or Save As. From this menu,
you can also load a previously saved session or delete one.

3 If you previously made a selection of clips, it will appear in the list. Otherwise, click Select.
A browser appears.
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Select Source Clips

Selection layout  View Bookmarks

¥ MAF_tests 15:16:16+15
* RED_TimeCode_shots |_-':.—I.
¥ TEST '
XDCAM EX
> tmp A0D1_C090_082 >
= wt
* selinux
> tmp

* usr

Clip Details

Done  Select clips and click 'Add’.

4 Select one or more clips and click Add. When you are finished, click Done.
The selected clips appear in the Input Clips list.

Export

Input = Output Settings | Submit

Sourc Path
OceanTile : ameZ010Project/Exporti0f

5 Click the Output Settings tab and set your encoding options, as desired.
You can select multiple output widths.
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Export

Input | Output Settings | Submit

Output Width
11820
[ 1280

Low
Quality

I I . I . I . I . ‘ —

960

[ 720

[ 640
[ 480
[ 360
11

| Custom

W Square Pixels

NOTE For information on defining the values of the steps in the Quality slider, see Customizing Encoding

Presets on page 56.

6 Click the Submit Job tab and click Export.

Export

Input | Output Settings || Submit

A progress bar appears to indicate how much of the job has completed.

7 Click Done to continue.
The Submit Job tab reappears with new options.
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Export

Input = Output Settings = Submit

Export View Content...

Create Package...
Dowload package available at this location:

http:/fcardigan.rd.discreet. qc.cafWiretapCentralfexport/export_Job.tar Copy to Clipboard '

8 Click View Content to open a new browser displaying the server directory containing the generated
clip.
The directory created on the server is based on the export session name.

WiretapCentral 2010 Extension 1 exports encoded clips to the following directory, as seen by a Web
browser:

http://<hostname or IP>/wiretapcentral/export/<session name>/
9 Click Create Package to add the clip, or clips, to a TAR file.
You can copy this path to the clipboard and then paste it in a browser to access the file.
You can also view this, and all created, packages. From the Export menu, click View Packages.

You should download the files once the encoding is complete to avoid losing them if the storage capacity
is reached.

10 When you are done, close the window.
You can also return to the previous tab to export other formats of the same clips.

Customizing Encoding Presets

When you submit an encoding job in the WiretapCentral 2010 Extension 1 UI, the WiretapCentral 2010
Extension 1 ffinpeg encoder is called with a series of command-line parameters, depending on the codec
preset and quality level selected in the Export window.

These presets are stored in the export_presets.xml file, located at /var/www/html/wiretapcentral/presets/ on the
WiretapCentral server machine.

Each preset defines the audio and video encoding format and parameters, as well as the video encoding
quality.

WiretapCentral 2010 Extension 1 provides a number of useful default presets. Advanced users are encouraged
to add new presets, or modify existing presets to better suit their needs.

To modify encoding presets:

1 Open a terminal to the WiretapCentral 2010 Extension 1 server machine, and log in as root.
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Open the file /var/www/html/wiretapcentral/presets/export_presets.xml in a text editor, such as nano.
B Each encoding preset is defined by a <preset> node in the XML file.

B Fach <preset> node has an <audio> child node that defines the audio codec parameters, and a
<video> child node that defines the video codec parameters.

B <audio> nodes have a <base> child node that defines audio encoding parameters.

B <video> nodes have a <base> child node that defines most of the video encoding parameters,
as well as a number of <quality> child nodes that define the steps of the Quality slider in the
Export window for that preset.

Modify the parameters in the <base> nodes, as well as the number and values of <quality> nodes.
The number of <quality> nodes in the XML file for a preset will be reflected by the number of steps
in the Quality slider for the respective preset.

Save and close the export_presets.xml file, and refresh the Web browser that points to WiretapCentral
2010 Extension 1.

NOTE Incorrect parameters may cause encoding jobs to fail. Read the information available online about ffmpeg
parameters before making changes.

If an encoding job fails without a clear error message after you have modified export preset settings, perform
the following procedure to obtain detailed error information from the codec.

To troubleshoot clip encoding:

1

In the Export window, click View Presets.

A new browser window opens to the
http://<hostname or IP>/wiretapcentral/export/<session name>/ URL.

Where <session name> is the name of the failed export job.

The list of files in the export session is displayed, including a file named info.txt .

Click the info.txt file.
The browser displays the contents of the file.

Locate the “Full command (execute as apache or root):” line at the end of the file.

The next line in the file contains the command and parameters that were sent by WiretapCentral 2010
Extension 1 to the codec when attempting to encode the clip.

Select the entire line and copy it to the clipboard.

Log into the WiretapCentral 2010 Extension 1 server machine as root, paste the command, and run it.
The codec outputs detailed messages on the reason for the failure.

Refer to online ffinpeg discussion groups for information on how to troubleshoot the reported problems.
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